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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

indicates that minor personal injury can result if proper precautions are not taken.
 

 
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Preface 1
1.1 Preface

Purpose of the Manual
This manual covers the basic description of batch trending with BRAUMAT/SISTAR Classic 
V6.0 and gives you an overview of the following topics:

● Engineering

● Batch relation

● Triggering

● Visualization

● Manual inputs

● Archiving

● Installation and Configuration

This manual is intended for those responsible for configuring, commissioning and servicing 
automation systems.

Where is this Manual valid?
This manual is valid for the software package BRAUMAT/SISTAR Classic  from Version V6.0.

The offered electronic manual is most largely identical with the contents of the on-line help. 
Due to a technically necessary editorial deadline for the generation of electronic manuals 
occasionally small deviations may occur compared to the on-line helps. The statements in the 
on-line helps take priority over those of the manual.

Place of this Documentation in the Information Environment
This manual forms part of the BRAUMAT/SISTAR Classic V6.0 documentation package. The 
following schematic of the document architecture shows the individual manuals as well as their 
thematic grouping within the entire program package.

Batch trending
Function Manual, 11/2012, A5E00239387-09 7



Document structure
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Further Support
If you have any technical questions, please get in touch with your Siemens representative or 
agent responsible.

You will find your contact person at:

http://www.siemens.com/automation/partner (http://www.siemens.com/automation/partner) 

You will find a guide to the technical documentation offered for the individual SIMATIC Products 
and Systems here at:

http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-
doku-portal) 

The online catalog and order system is found under:

http://mall.automation.siemens.com/ (http://mall.automation.siemens.com/) 

Training Centers 
Siemens offers a number of training courses to familiarize you with the SIMATIC S7 automation 
system. Please contact your regional training center or our central training center in D 90026 
Nuremberg, Germany for details: 

Internet: http://www.sitrain.com (http://www.sitrain.com) 

Technical Support
You can reach the Technical Support for all A&D products

Via the Web form for the Support Request
 http://www.siemens.com/automation/support-request (http://www.siemens.com/automation/
support-request) 

Additional information about our Technical Support can be found on the Internet pages http://
www.siemens.com/automation/service (http://www.siemens.com/automation/service) 

Service & Support on the Internet
In addition to our documentation, we offer our know-how online on the Internet at:

http://www.siemens.com/automation/service&support (http://www.siemens.com/automation/
service&support) 

where you will find the following:

● The newsletter, which constantly provides you with up-to-date information on your products.

● The right documents via our Search function in Service & Support.

● A forum, where users and experts from all over the world exchange their experiences.

● Your local representative for Automation & Drives.

● Information on field service, repairs, spare parts and more under "Services".

Preface
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Batch curves 2
2.1 Overview

● The BRAUMAT/SISTAR Classic V6.0 system records batch-oriented measured value 
curves. The triggering process happens in the PCU. It triggers groups of curves rather than 
individual measured values. Measured values can be divided into up to a maximum of 240 
curve groups.

● They are recorded from a server. On the server the application 'trendmanager' must run.

● If measured values are recorded by a server, the number of variables is reduced to the 
quantity that the server is able to provide at any given moment.

● More than 1 server can record curves in the plant.

● A compression procedure is used during recording.

● A list describing the measured values needs to be created. The list describes all measured 
values to be recorded. For each server this list may contain up to 1200 entries for analog 
measured values and 2400 entries for digital measured values.

● The digital measured values can be derived from all the analog measured values that are 
available.

● BRAUMAT/SISTAR Classic V6.0 can also include weekly files and short-time records 
besides batch curves.

● Curve visualization is provided by a client application, which can run on each BRAUMAT/
SISTAR Classic V6.0  system.

● The client can visualize measured values from different curve servers.

● An aggregation of several values is called a "curve picture“.

● It is possible to put several curves on top of each other and move and stretch them for the 
comparison.

Note:
On account of a modified telegram structure in the batch relevant client-server communication 
the following restriction exists:

When upgrading existing process cells, please note that, as of BRAUMAT/SISTAR Classic 
V5.3, there is no support for composite configuration in terms of client and server IOS system 
versions. It is not possible e.g. to access stored curves on a V5.2 server from a V5.3 client 
and vice versa. Upgrades should always be consistent between Client IOS and Server IOS.
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Configurations
● Single-user configuration

Curve record as well as curve visualization run on the same OS.

● Client - server configuration
There is a curve record on one or two redundant servers and the curve visualization is 
available on all clients.

● Multi client - server configuration
On the server as well as on the clients, measured values from several servers are 
visualized. 

2.2 Measured value type
Measured values must be assigned one of the following types:

● 1: Short-term curve
This measured value can only be used in short-term record files.
They run automatically, i.e. do not need a curve trigger from the control system.

● 2: Batch archive
The measured value can be used in batch archives and in weekly archives.
They do not run automatically, i.e. they need a start trigger and a stop trigger from a control 
system.

● 3: Weekly archive
This measured value can only be used in weekly archives.
Run automatically if 255 is used as curve group. If curve groups 1-240 are used, a trigger 
from a control system is required.

2.3 Curve group
 

A curve group contains several values, which are related in a technological manner. Recording 
is enabled or stopped for the whole group, whereas at most 240 groups can be configured.

Grouping of curves is performed during engineering of the description list mentioned above.

2.3.1 Status of the curve groups
The PCU software includes a trigger data block, which aggregates the actual information 
relating to all curve groups (status list). The data record of a curve group includes four data 
words

(DB689 in SIMATIC S7).

Batch curves
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Structure of the data block

Address (in DW) Meaning  
Offset Offset Has the value 2
Offset + (n-1)*4 Job number n = Group number
Offset + (n-1)*4 + 1 Batch number n = Group number
Offset + (n-1)*4 + 2 Year/Recipe type n = Group number
Offset + (n-1)*4 + 3 Recipe number n = Group number

2.4 Triggering curves
Triggering (enabling/stopping) data collection within the PCU is performed by a function block 
trigger function block (FC695). Batch information as well as the curve group number is provided 
for this block. 

The function block is called by recipe procedures (Unit FB or basic operation). 

2.5 Compare curves
The Option “Compare curves“ provides the possibility to view several batch or weekly archives 
simultaneously for comparison purposes. In this way you can distinguish between two 
functions. 

Free selection
Function 1:
You can open up to 8 batches or week archives for a configured curve picture (selection of 
measured values). The graphs can be moved in order to match them for an easier comparison. 

Function 2:
By “free selection” you can select curves from different batches. This selection is used as a 
reference (Step 1 of Selection) for comparison with another batch.

Compare curves
In order to determine the quality of a produced batch, the curve graphs of one batch or selection 
(step ‘Free Selection’) can be compared with the corresponding curves of another batch.

 

 Note

If digital values are configured in the opened curve picture too, the comparison feature is not 
selectable.
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Enable
In general, the function must be enabled.

File …\windcs\sys\kurven.ini:
Input [Select]
Key CmpOptionEna=1

2.6 Archive editor
The archive editor is used for:

● entering manual values into the file and the transfer of these input values into the PCU,

● the manual modification of curve values

Batch curves
2.6 Archive editor
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AS Engineering 3
3.1 General

This chapter describes what to do in the PCU and how to configure it in order for curves to be 
recorded.

3.2 How 'triggering' works
Batch information is transferred into the trigger data block by starting the trigger.

In addition the Trendmanager is informed about the start of a record for the curve group.

The Trendmanager reads the batch data and starts by recording the corresponding curve 
group.

By stopping records a message is sent to the Trendmanager, which stops the recording of 
measured values for this group.

3.3 Batch reference of trigger data block
● Direct input of the batch reference (iSEQID = 0; boACTSEQ = 0)

● Indirect addressing via sequencer number (iSEQID > 0; boACTSEQ = 0)
The batch reference is read from the sequencer data record, which is indicated via the 
parameter iSEQID .

● Indirect addressing via sequence number, which is actually processed (iSEQID = 0; 
boACTSEQ = 1);
this is only possible in the S7 version.

3.4 Input parameter of the trigger function block

iID (integer; from 1 – 240)
The curve group number must be provided manually and must be the same as configured in 
the measured value description list.

byRecCat, byYear, iOrder_No, iBatch_No, iRecip_No
The batch reference can be provided directly via these inputs. The parameters are transferred 
into the trigger DB when starting the group.  
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boRun (Bool)
A rising edge at this input parameter starts recording values for this group. The input 
parameters RecCat, Year, Order_No and Batch_No are taken as batch information at the time.

boActSeq (Bool)
This input parameter is only used in the "BRAUMAT based on S7” version and means that the 
batch reference is taken from the sequence which is currently being processed.

iSeqID     (Integer)
This input parameter references the sequencer (number) from which the batch reference 
should be taken.

3.5 Call examples

Direct input of the batch reference 
The start and the batch reference can be provided independently by the sequencer with this 
call:

 CALL "TRIGG_CURVE_GR_FC" boRUN :=TRUE boACTSEQ :=FALSE iID :=0 
iSEQID :=0 byYEAR :=B#16#1 byRECCAT :=B#16#1 iORDER_NO :=4711 
iBATCH_NO :=1 iRECIP_NO :=1

Indirect indication by Sequencer number
This call is necessary for background tasks of a sequence, which run independently of the 
sequence process itself but should trigger the curves anyway.

 CALL "TRIGG_CURVE_GR_FC" boRRUN :=TRUE boACTSEQ :=FALSE iID :=0 
iSEQID :=10 byYEAR :=B#16#0 byRECCAT :=B#16#0 iORDER_NO :=0 
iBATCH_NO :=0 iRECIP_NO :=0

Indirect via currently processed sequence
This call is only useful in the S7 version. You should call it in an EOP/EPH (FC1001 – FC1999) 
or in the sequencer function block (FB1001 – FB1064). Only the curve group and the parameter 
'boACTSEQ' = 1 should be provided; all other parameters are irrelevant.

 CALL "TRIGG_CURVE_GR_FC" boRUN :=TRUE boACTSEQ :=TRUE iID :=0 
iSEQID :=0 byYEAR :=B#16#0 byRECCAT :=B#16#0 iORDER_NO :=0 
iBATCH_NO :=0 iRECIP_NO :=0

AS Engineering
3.5 Call examples

Batch trending
16 Function Manual, 11/2012, A5E00239387-09



3.6 Telegram for triggering
Buffers (FIFOs) must be configured for the trigger telegrams (type 18). The message type must 
be configured for one of three FIFOs for the server. If curves are recorded in parallel, two FIFOs 
must be configured - FIFO 3 or FIFO 6 should be used as a default configuration.

Direct input
The input of the message type can be performed directly via the parameterization tool. 
However, you can use the automatic configuration during server startup.

Server startup
You can let the system parameterize the FIFOs during the startup of a server; this is then done 
automatically but must be activated via the application “system adjustments” by pressing the 
button 'FIFO configuration'.

Then define and activate the FIFO configuration.

AS Engineering
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Please enter the message type 18 and enable the check box.

The standard message types for the recipe system and route control are configured 
automatically and do not need to be preselected.

AS Engineering
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Installation and Operation 4
4.1 Application “trending definition”

The standard installation includes the appropriate entry in the BRAUMAT/SISTAR Classic V6.0 
Main Menu ('Engineering tools' tab).  

4.2 Starting the Trendmanager
For recording batch curves you must start the application 'Trendmanager' (trendman.exe) on 
the server, doing this in different ways.

● Manually:
This type is not recommended since you can easily forget the start of the curve record.

● With the Main Menu:
1. Old AREA.INI format
Via an adjustment in the file '\windcs\sys\sys.ini' you can configure the system to start to 
record the curves.

Input: [PC]
Key: AutoStart=trendman.exe

● 2. Extended AREA.INI format
The key is in "\windcs\sys\area.ini". You can enter the key by means of the ‘System 
settings'→'Configtool' (SiteCfg.exe) application. In the IOS Settings dialog please enter 
‘trendman.exe’ in the Autostart field

4.3 Trendmanager window
The Trendmanager has no operator interface in the standard operation, runs as process on 
the server and is displayed as an icon in the toolbar. The window cannot be opened directly. 

Pressing the 'ALT‘ key and clicking on the icon at the same time will open the window, which 
lists all curve groups and their actual batch information:

Batch trending
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The window can be opened automatically when the program starts by means of the following 
settings in "\windcs\sys\trendman.ini":

Input [Window]
Key Show=1

4.4 Configuration of batch curves
 

You can make modifications for batch curves, by editing the file '\windcs\sys\trendman.ini‘ in 
an ASCII editor.

 

 Note

Further information is available from the Simatic Customer Support Center (addresses/
partners are found in the preface (Page 7) of this manual).
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4.4.1 Configuring the server

Server
All curve servers are configured in this section, whereby it is possible to enter more than 1 
server. The servers must be separated by a ; (semicolon). The syntax for each server is <IOS-
Nr>$<Path>. <Path> defines a network path of the curve server. 

Input: [Network]
Key: Server=1$\\IOS01\c\windcs

4.4.2 Configuring recording

StoreOnExit
Save data before closing the application ON (default) / OFF.

Input: [App]
Key: StoreOnExit=1

STBufferSize
Size of the buffer for short-term curves. The default value is 150, the allowed range is 60 to 
1800.

Input: [App]
Key: STBufferSize=150

StartMark
Enables (1, default) or disables (0) saving additional user information, when start trigger rises.

Input: [App]
Key:  

StartMark=0 (Default)
When trend recording is switched off by the curve trigger function or by closing Trenman.exe 
and then switched on again, the off value is linked to the start value, i.e. the user does not see 
that trend recording was interrupted. 

Installation and Operation
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Startmark=1
This sets a start flag at 80000000 hex in the curve archive each time trend recording is started. 
This value is not shown as a curve value, but is only an identifier for the curve output. The end 
value is thus not linked to the start value in the curve display, i.e. the curve is interrupted at 
this point, and the user can detect this interruption. 

FlushCycle
Measured values are recorded in intervals according to the configuration in the measured value 
description list. In order to reduce the amount of hard disk accesses, the measured values are 
collected in the main memory of the server and written on the disk after a certain time. The 
cycle for storing can be defined by this indication (in seconds, default is 15 seconds). If there 
is a failure on the server, the values which are held in the main memory will be lost.

Input: [App]
Key: FlushCycle=15

DiffTime
Measured values in BRAUMAT/SISTAR Classic V6.0  are already recorded in a compressed 
form; values are only recorded if the difference between the old and the new value exceeds a 
certain hysteresis value. 

Therefore it could be possible that a value will not be recorded for a very long time. This could 
cause disadvantages in regard to data security. 

The user can force writing the value onto disk at least after a given period of time (in seconds, 
the default value is 3600 seconds (60 minutes)). 

Input: [App]
Key: DiffTime=3600

4.4.3 Configuring the client
For showing curves on a client the user must enter parameters in the file ...\windcs\sys
\trendman.ini: 

Input [Network]
Key HostIPAddr=192.168.1.1

Enter the IP address of the assigned curve server.

Installation and Operation
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4.4.4 Configuring folders
Paths can be defined for batch curves for data reading and writing. They are compiled in 
categories. Paths for the categories are indicated in the '\windcs\sys\sys.ini' file. There is more 
than one path possible for a category.(  See also:  Installation&Configuration  9.3)

The batch curves always take the first entry, parameters must be separated with ; (semicolon). 

All data for the batch curves are written and read via the category 'Configuration'. 

Category: Configuration

Input: [Paths]
Key: Proj=

4.5 Redundancy

Curve record
Curves can be recorded redundantly by two servers, which run independently of each other. 

Client
A client is connected to 1 server. If this server fails, the user must modify the client configuration 
manually to access the other server.

There is no automatic switch-over to the other server.

4.6 Where the data is located

Topic
The following files are important:

 'windcs\trend\ini\measdesc.def'
This is the description file for the analog measured value description list. The file is copied 
during the installation and must not be changed, as it contains the structure of the data records 
for a measured value.

0    structure of measured value description list
97 
1     MEASURE_NR    CINT  3    measured value number
4     BLOCK_NAME    CHAR  6     block name 

Installation and Operation
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10    DATAR_NAME    CHAR 16     data record name 
26    DATAR_NR      CINT  4     data record number
30    DATAR_ELEM    CHAR  6     data record element
36    REL_ADD       CINT  3     relative address
39    ACQ_CYCLE     CINT  5     acquisition cycle
44    INF_LIMIT     CINT  6     inferior limit
50    SUP_LIMIT     CINT  6     superior limit
56    HYSTER        CINT  5     hysteresis
61    DIMENSION     CHAR 16     dimension 
77    DEC_POINT     CINT  2     decimal point
79    HANDLING      CINT  1     archive handling
80    GROUP_NR      CINT  3     group number 
83    PCU_NR        CINT  3     PCU number
86    BIT_DW_DRL    CINT  2     Bit/DW/DL/DR ID
88    SOURCE_TYP    CINT  2     source type
90    SOURCE_NR     CINT  3     source number
93    DW_NR         CINT  4     DW number

 'windcs\trend\ini\measdesc.dbf'
Analog measured value description lists are stored into this file (dBase format). 

 'windcs\trend\ini\digidesc.def'
This is the description file for the digital measured value description list. The file is copied 
during the installation and must not be changed. The structure of the data record for a digital 
measured value is defined in this file.

0    structure of digital value description list
25 
1     MEASURE_NR    CINT  3    measured value number
4    BIT_FROM      CINT  2    from which bit
6    BIT_TO        CINT  2    to which bit
8    CONNECT       CHAR  1    connection
9    DIGIT_NAME    CHAR 16    name of digital value

 'windcs\trend\ini\digidesc.dbf'
Digital measured value description lists are stored within this file (dBase format). 

Installation and Operation
4.6 Where the data is located
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sub folder 'windcs\trend\picture‘
Configured pictures are stored in this sub folder, where three different file types exist (different 
archives):

● *.st (short time) Short-time archive

● *.ltb (long time batch) batch archive

● *.ltw (long time week) weekly archive 

.

sub folder 'windcs\trend\data.xxx‘
The recorded values are stored into this directory. In order to reduce the amount of files per 
sub folder, the system creates a sub folder for every 50 measured values, e.g. the sub folder 
“data.050” contains records of the measured values # 1 up to # 50.

4.7 Storage of the pictures
In the standard delivery of the system all pictures are stored in the client's system folder.

This behavior can be changed.

File: kurven.ini
Input: [Options]
Key: SynchonizeFiles=

Value: 1
The picture files are loaded from the first folder entry in the file sys.ini (Key: PROJ). The pictures 
are stored to all entries under the PROJ folder. 

Value: 0 (Default)
All pictures are loaded and stored to the local system folder.

Installation and Operation
4.7 Storage of the pictures
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Configurations 5
5.1 Single-user configuration

The recording and visualization of curves are both running on the same OS.

Configuration of 'trendman.ini‘
● [Network]

Server=<IOSNo>$<System path> 
The system path can be a local drive, e. g. c:\windcs)

● [Network]
HostIPAddr may be configured as a local IP address or left empty.

All data is recorded and read locally on the computer.

Trendman.ini for the example
[Network]
;SISTAR directories of other computers (<IOS-Nr>$<Path>)
Server=1$C:\WINDCS
;IP address used by KURVEN to connect to TRENDMAN (Win32 only)
;HostIPAddr=127.0.0.1
;New IOS-Init.-Flag. Server-IOSen now shown in the real way
NewInit=1
Sys.ini for the example
;[Paths]
;Path for project
PROJ=c:\WINDCS

Batch trending
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5.2 Client - server configuration
The recording of curve values is running on one or two redundant servers and the curve 
visualization is available on all clients.

Image ???

Configuration of 'trendman.ini‘
● [Network]

Server=<iosNr> $ <System path of the Server> 
The system path must be entered as computer and share name, e.g. \\ios01\c\windcs ). 
Sharing must be available on the server machine. This key is used for the clients in order 
to access the corresponding data on the server. 
This sharing is only necessary on the server.

● [Network]
HostIPAddr=IPAdr of the server
The key is only important on client machines

Configuration of 'sys.ini‘
● [Path]

Proj=<system path of the server>
! This path setting also affects all other functions of BRAUMAT/SISTAR Classic V6.0. 
The path is important for the editor 'measured value description list' and the Trendmanager. 
The curve visualization uses this path depending on the settings.  See also:  Storage 
of the pictures

● System path of the Client
In order to enable the client to display the trend pictures, these must be stored on the client's 
local hard disk drive under windcs\trend\picture.

● The curve visualization uses this path depending on the settings.  See also:  Storage 
of the pictures

Configurations
5.2 Client - server configuration
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INI files for the example:

Server1
Trendman.ini for Server1

[Network]

;SISTAR directories of other computers (<IOS-Nr>$<Path>)
Server=1$\\IOS1\c\WINDCS
;IP address used by KURVEN to connect to TRENDMAN (Win32 only)
;HostIPAddr=127.0.0.1
;New IOS-Init.-Flag. Server-IOSen now shown in the real way
NewInit=1
Sys.ini for Server1
;[Paths]
;Path for project
PROJ=\\IOS1\c\windcs

Server2
Trendman.ini for Server2

[Network]
;SISTAR directories of other computers (<IOS-Nr>$<Path>)
Server=2$\\IOS2\c\WINDCS
;IP address used by KURVEN to connect to TRENDMAN (Win32 only)
;HostIPAddr=127.0.0.1
;New IOS-Init.-Flag. Server-IOSen now shown in the real way
NewInit=1
Sys.ini for Server2
;[Paths]
;Path for project
PROJ=\\IOS2\c\windcs
 

Client 1
Trendman.ini for Client1

[Network]
;SISTAR directories of other computers (<IOS-Nr>$<Path>)
Server=1$\\IOS1\C\WINDCS
;IP address used by KURVEN to connect to TRENDMAN (Win32 only)

Configurations
5.2 Client - server configuration
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HostIPAddr=10.0.0.1
;New IOS-Init.-Flag. Server-IOSen now shown in the real way
NewInit=1
Sys.ini for Client 1
;[Paths]
;Path for project
PROJ=\\IOS1\c\windcs;\\IOS2\c\windcs;

Notes:
● For the client the following is valid:

Concerning the paths the trendman.ini of the corresponding server is relevant - and not its 
own!

● A global host file should exist on all clients and servers of the system under the Windows 
directory "system32\drivers\etc".
Example of a host file
10.0.0.1 IOS1
10.0.0.2 IOS2
10.0.0.11 CLIENT1
10.0.0.12 CLIENT2
10.0.0.21 CLIENT3
10.0.0.22 CLIENT4

5.3 Multi client - server configuration
This configuration consists either of a single server or several redundant servers. On the server 
as well as on the clients, measured values from several servers are visualized. 

Configurations
5.3 Multi client - server configuration
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Curve visualization/archive editor
The Client always accesses a curve server, which has the connection to the other server and 
reads the measured value description and the data from there. 

The pictures of the archive editor are always read locally, therefore all pictures of all servers 
must be held on all the clients.

Measured value description list
The application 'measured value description list' cannot run on multiple clients, it can only 
access the local list on a server. The configuration is made via the key [Path] 'Proj'= in file 
'sys.ini‘. Each server pair has its own measured value description list.

Adjustments in 'trendman.ini‘
● [Network] 

Server=<IosNo> $ <System path Server 1> ; <IosNo> $ <System path Server 3> ; ...
The system path must be entered as machine name and shared folder, e.g. "\\ios1\c
\windcs"). The server must have this share. This key is used for the clients in order to access 
the corresponding data on the server.

● [Network]
HostIPAddr=<IPAdr of the server>
The setting is important for clients (one address only).

Adjustments in 'sys.ini‘
● [Path]

Proj=<system path of the server>
! This path setting also affects all other functions of BRAUMAT / SISTAR Classic V6.0. 
The path is important for the editor 'measured value description list' and the Trendmanager. 
The curve visualization app, however, does not use this path setting.

● System path of the Client
Depending on the setting, the trend visualization function reads the trend pictures from the 
system folder. In order to enable the client to display the trend pictures, these must be 
stored on the client's local hard disk drive under windcs\trend\picture. In this system 
configuration, the trend picture names must be unique.

●  See also:  Storage of the pictures

INI files for the example:

ServerA
Trendman.ini for Server1

[Network]
;SISTAR directories of other computers (<IOS-Nr>$<Path>)
Server=1$\\IOS1\C\WINDCS;3$\\IOS3\c\windcs
;IP address used by KURVEN to connect to TRENDMAN (Win32 only)

Configurations
5.3 Multi client - server configuration
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;HostIPAddr=127.0.0.1
;New IOS-Init.-Flag. Server-IOSen now shown in the real way
NewInit=1
Sys.ini for Server1
;[Paths]
;Path for project
PROJ=\\IOS1\c\WINDCS
ServerA can thus visualize its own trends and those of ServerB.

ServerB
Trendman.ini for Server3

[Network]
;SISTAR directories of other computers (<IOS-Nr>$<Path>)
Server=3$\\IOS3\C\WINDCS; 1$\\IOS1\c\windcs
;IP address used by KURVEN to connect to TRENDMAN (Win32 only)
;HostIPAddr=127.0.0.1
;New IOS-Init.-Flag. Server-IOSen now shown in the real way
NewInit=1
Sys.ini for Server3
;[Paths]
;Path for project
PROJ=\\IOS1\c\WINDCS
ServerB can thus visualize its own trends and those of ServerA.

Client 1
Trendman.ini for Client1

[Network]
;SISTAR directories of other computers (<IOS-Nr>$<Path>)
Server=1$\\IOS1\c\WINDCS
;IP address used by KURVEN to connect to TRENDMAN (Win32 only)
HostIPAddr=10.0.0.1
;New IOS-Init.-Flag. Server-IOSen now shown in the real way
NewInit=1
Sys.ini for Client 1
;[Paths]
;Path for project
PROJ=\\IOS1\c\windcs;\\IOS2\c\windcs

Configurations
5.3 Multi client - server configuration
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The ServerA and ServerB trends can be visualized on Client1. To 
enable this function ServerA must be able to visualize the trends of 
ServerB, and the trend manager must be running on ServerA.

Notes:
● For the client the following is valid:

Concerning the paths the trendman.ini of the corresponding server is relevant - and not its 
own!

● A global host file should exist on all clients and servers of the system under the Windows 
directory "system32\drivers\etc" (for area A and B).
Example of a host file
10.0.0.1 IOS1
10.0.0.2 IOS2
10.0.0.3 IOS3
10.0.0.4 IOS4
10.0.0.11 CLIENT1
10.0.0.12 CLIENT2
10.0.0.21 CLIENT3
10.0.0.22 CLIENT4
...

● In the case of extended (new) AREA.INI  format the path entries in file SYS.INI are not 
required.

Configurations
5.3 Multi client - server configuration
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Measured value description list 6
6.1 General

All measurement values to be recorded must be configured in one of two measured value 
description lists: BRAUMAT/SISTAR Classic V6.0 always distinguishes between analog 
measured values and their derived digital values. Each one of these groups is available in a 
separate database file which the user should not directly edit. The measured value description 
list Editor (MVDL Editor) unites both lists on one user interface.

Call:

→
"Engineering tools" tab

→

To apply the deltas in a measured value description list, you need to restart the TREND-
MANAGER.

The system can only record a limited number of scanning instants. Under the assumption that 
all scanning instances are saved, the following interrelation can be used to calculate the 
smallest possible sampling cycle.

min. sampling cycle = max. recording time in seconds/number of points

The practical high limit (with acceptable performance) of the number of scanning instants is 
approx. 10,000, although the theoretical high limit is a rate of approx. 1,000,000.

6.2 Analog values

6.2.1 Attributes
An analog measured value is characterized by the following attributes:

ID (Identification)
System-wide unique identifier of the measured value. Directly dependent on this are the 
derived digital values and the trends based on this measured value.
This number also defines the file name used in the archive on the hard disk drive.
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Permitted number of entries: 1 to 1200.
 

 Note
Constraint for S5 PCUs:

Up to 1020 analog measured values are supported per S5 PCU; however, a range of 1 to 
1200 also applies to the ID area.

 

Measured value description
Forms the name of the measured value and the caption for the trend.
The maximum length of the name is 16 characters and it may not contain any special 
characters.

Addressing
Analog measured values can be addresses in two ways:

1. By direct definition of an absolute address (in the Editor: "Absolute")

2. By an attribute of a system or user object (in the Editor: "System")

PCU
The measured value must originate from a control; here, the PCU number assigned in the 
system control is expected.

Class
Only relevant for the "System" source version: the Braumat class of the recorded measurement 
value.

Instance
Only relevant for the "System" source version: the Braumat instance number of the recorded 
measurement value.

Attribute
Only relevant for the "System" source version: the Braumat attribute of the recorded 
measurement value.

Absolute address
Relevant for addressing type “Absolute” only: a Simatic address in a STEP 7 syntax (e.g. 
DB712.DBW18). For an S5 machine an equivalent syntax is expected (e.g. DB712.DW18). 
For absolute addressing, the input, output or Flags/Memory ranges in AWL-Syntax may be 
defined as well (e.g. E35.7, M99.1, MW 132, AB22).

Measured value description list
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Archive type
Every analog measured value has to be assigned one of these four possible archive types:

● Short-time archive

● Batch archive

● Weekly archive

● Manual archive

Curve group
Number of the curve group to which this value should belong.

Refresh
Recording cycle, that is timing interval between two scans in seconds. Valid range is 2 to 32767 
seconds. The real cycle depends on the hysteresis and the slope of the curve.

Lower limit
Minimum value of the scaling in the picture.

Upper limit
Maximum value of the scaling in the picture.

Hysteresis
For long-term curves: Tolerance band where a value is stored if it is not within this range.

The hysteresis is not used for short-time archives.

Dimension
Unit of the measured value (e.g. °C, min, …) 

This will later appear below the measurement value name in the form of a legend to the curve 
picture.

Decimal point
Number of digits for the axis marking.

Measured value description list
6.2 Analog values
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6.2.2 Data types and limits
For data types and limit values there are several unusual features to take into consideration:

Simatic raw type Interpretation Lower limit Upper limit
DBB, EB, AB, MB unsigned 

8-bit integer
0 255

DBW, EW, AW, MW signed 16-bit integer -32 768 32 767
DBD, ED, AD, MD signed 32-bit integer -99,999 (s.b.) 999 999 (s.b.)
REAL (not supported)   

For historic reasons of downward compatibility, we have restricted the field length of the high 
and low limit attributes to six characters. 16-bit integer values do not represent a problem, 
whereas the representation of a 32-bit integer (DINT) value requires a significantly higher 
number of characters. The usable DINT limits and thus the range of measurement values listed 
above are the result of this restriction.

6.3 Digital values
In addition to analog values you can also record and display digital values. Digital measured 
values are not inserted directly, but are derived from recorded analog measured values.

● Up to 2400 digital measured values are available per curve server

● These can be derived from the individual bits or bit ranges of the assigned analog measured 
values (of which there can be up to 1200)

 

A digital measured value is defined by the following attributes:

Associated analog value
The digital value is assigned to the analog measured value in the editor using ID 1 ... 1200. 
This is done by selecting it and calling the "Derive new digital measured value" function. This 
assignment is retained even if you change the ID of the linked analog value.

Measured value description
Name of the measured value as it will appear as a caption in the trend visualization. It may 
only be a maximum of 32 characters and must not contain any special characters.

Start bit
First bit within the measured value for a bit range that is going to be evaluated

End bit
Last bit within the measured value for a bit range that is going to be evaluated 

Measured value description list
6.3 Digital values
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If only one individual bit of a measured value is going to be evaluated, the start and end bit 
must be identical.

Combination type
If multiple bits of a measured value are going to be evaluated for the purpose of a digital 
measured value (start and end bit are different), the type of logic operation has to be defined. 
You can select either an AND or an OR logic operation.

If the start and end bits are identical, this attribute is irrelevant.
 

 Note

The bit range that can be configured for digital measured values is always 0 to 15 (maximum), 
even if the underlying measured value is a double word (i.e. consists of 32 bits).

 

6.4 Handling the editor
 

You can edit analog measured values and their derived digital values in the MVDL Editor. The 
user interface consists of two table views which are handled in accordance with the standard 
Windows features.

6.4.1 Elementary usage

Shortcuts

Program
<Ctrl> S Save trending definition
<Ctrl> P Print analog or digital trending definition
<Ctrl> <Shift> P Print preview for analog or digital trending definition
Edit
<Ctrl> Z Undo
<Ctrl> Y Redo
<Ctrl> X Cut current line
<Ctrl> C Copy current line to clipboard
<Ctrl> V Insert line from clipboard after current line
<Ctrl> <Shift> V Insert line from clipboard before current line
<Del> Delete current line
<Ctrl> N Insert new line after current line
<Ctrl> <Shift> N Insert new line before current line
<Ctrl> <Alt> N Derive a new digital measured value from current analog measured value

Measured value description list
6.4 Handling the editor
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Program
Views
<Ctrl> <TAB>
<F6>

Toggle between views of analog and digital measured values

Toolbar buttons

Save trending definition

Print analog or digital trending definition

Print preview for analog or digital trending definition

Cut current line

Copy current line to clipboard

Insert line from clipboard after current line

Undo

Redo

Optimize column widths for current view

Toggle: Show all digital measured values or only those which are derived from current 
analog measured values

6.4.2 Create new analog measured values

Alternative 1: the main menu

Measured value description list
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Alternative 2: By means of the shortcut menu in the "Analog values" view (right-click on the table view)

Alternative 3: keyboard shortcuts
As indicated above, the keyboard shortcut is a faster means of inserting a new definition:

● <Ctrl>+<Shift>+N New definition line before current line

● <Ctrl>+N New definition line after current line

6.4.3 Create new digital measured values
When creating digital measured values, you can also choose from three methods: 

● the main menu

● the shortcut menu

● a keyboard shortcut (<Ctrl> <Alt> N).
 

 Note

Digital measured values always have to be derived from analog measured values.
 

6.4.4 Editing measured values

Notes on the input of values
With the Editor, you have a highly efficient tool at hand for editing attribute values. 

You can basically select any value for editing by means of the shortcut key <F2>, with 
<ENTER>, or by double-clicking with the left mouse button. 

After you have edited a value, you can apply the changes and move to the next column by 
pressing the <TAB> key (does not apply to the pop-up selection boxes).

Measured value description list
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Editing possibilities

Table 6-1 Analog values

Column Description
ID
Measured value's 
desc.

(no special considerations for the input)

Addressing <F2>, <ENTER>, a double-click opens a selection box, Shortcut: "s" for 
"System", "a" for "Absolute"

PCU <F2>, <ENTER>, a double-click opens a selection box, Shortcut: PCU number
Class
Instance
Attribute

<F2>, <ENTER>, a double-click opens a selection box, Shortcut for an instance: 
instance number.
(if you prefer, you can also enter the class and attribute in text format. The text 
is not case-sensitive.)

Absolute address For SIMATIC S7: STEP 7-AWL-Syntax, for SIMATIC S5: a syntax associated 
with STEP 7 STL (e.g. DB712.DW8)

Archive type <F2>, <ENTER>, a double-click opens a selection box, Short input by means 
of the numbers known in previous system versions:
● 1 (short-term archive)
● 2 (batch archive)
● 3 (weekly archive)
● 4 (manual archive)

Curve group
Update
Lower limit
Upper limit
Hysteresis
Unit
Decimal point

(no special considerations for the input)

Table 6-2 Digital values

Column Description
Linked analog value (information only; cannot be edited)
Measured value's 
desc.
Start bit
End bit

(no special considerations for the input)

Logical connection <F2>, <ENTER>, a double-click opens a selection box, Shortcut: "a" for "AND", 
"o" for "OR"

 
 

 Note

All clipboard operations (Cut, Copy, ...) and the "Delete" command always relate to a complete 
measurement value line.

 

Measured value description list
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6.4.5 Print settings

Here you can set some of the printer defaults: separate page layout for analog and digital 
values and an adaptable footer.

The figure below shows you the layout of a printed page (portrait pages are shown in analog 
format): 

In the user text you can define the customer or the system, for example.

Measured value description list
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Curve visualization 7
7.1 Overview

The application 'PI curves' is used for a graphic output of measured values. It enables the time 
display of archived or running curve values as diagrams on the screen. 

Display of analog curves
You can assemble up to a maximum of eight curves. Each individual curve can be hidden. 
Furthermore the the user can print a screenshot of the curves. The user can zoom into a graph 
and get any absolute value from the archive with the corresponding point of time additionally.

The scale, unit and archive maintenance of the curve values are defined in the measured value 
description list.
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Display of digital properties
Digital curve properties of individual bits are displayed as follows:

● Condition "0" (graph with gaps)

● Condition "1" (colored graph)

Display
The following picture combinations are possible:

● Picture with analog curves only: up to 8 analog graphs

● Picture with digital curves only: up to 32 digital graphs

● Mixed picture: up to 8 analog and up to 16 digital graphs

Trendmanager
The visualization application requires a connection to the trendmanager app, which can run 
locally or remotely on a server.

It provides access to the curve archives, which are configured in the measured values 
description list. Graphs showing currently running batches are updated cyclically. 

7.2 Creating pictures
Three types of pictures are possible

● Pictures consisting of values from the 'short-term archive‘.

● Pictures consisting of values from the 'weekly archive‘.

● Pictures consisting of values from the 'batch archive‘.

Create a new picture by selecting “file/new” from the menu, a dialog appears, where the user 
can enter the name of the picture and select a curve type.

The user can select the short-term archive, batch archive or weekly archive.

After selecting an archive, first a dialog appears "edit analog measured values", then "edit 
digital measured values".

Curve visualization
7.2 Creating pictures
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7.3 Dialog 'edit analog measured values'
The dialog opens automatically when creating new pictures. If a picture is already open, select 
'File' → 'Edit' → 'analog measured values' in order to open this dialog. 

In this dialog, the user defines the values to be displayed by making a selection of both list 
boxes IOS and MEASURED VALUE, at most 8 values per picture can be selected.

In addition one out of 16 colors can be chosen,  then press “Add” to assign a value to the 
picture. Pressing "Remove" deletes the selected value from the current picture in the list box 
MEASURED VALUE IN PICTURE.

Only those values which could be added to a picture (analog/digital values) are shown.

7.4 Dialog 'edit digital measured values'
The dialog opens automatically when creating new pictures. If a picture is already open, select 
'File'  → 'Edit'  → 'digital measured values' in order to open this dialog. 

Curve visualization
7.4 Dialog 'edit digital measured values'

Batch trending
Function Manual, 11/2012, A5E00239387-09 47



In this dialog the user defines the digital values of a picture by selecting inputs of both list boxes 
IOS and MEASURED VALUE. Up to 16/32 values per picture are possible. Refer to “editing 
analog values”.

 

 Note

If the maximum of 16 or 32 values are exceeded, an error box is displayed. Values can be 
deleted now. Insertion of new values, however, is only possible after closing and reopening 
the picture.

 

 

Curve visualization
7.4 Dialog 'edit digital measured values'
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7.5 Meaning of the tool bar

Icon Topic Function

 

Standard button for BRAUMAT/SISTAR Classic V6.0 for ● Exiting the application
● Quitting ICM errors (only necessary 

for "BRAUMAT based on S7“)
● Quitting horn
● Resetting password

 

Open pictures ● Open pictures based on the short-
term archive

● Open pictures based on the weekly 
archive

● Open pictures based on the batch 
archive

Print a picture  

Show/hide additional information ● Ruler
● Show complete graphs
● Show all measured values (show 

hidden values)

7.6 Open pictures

7.6.1 Open pictures

Possibilities:
● Select “File/Open” and click on the desired curve type in the corresponding sub menu.

● Click on the icon in the button bar. 

A dialog appears, select a picture.

Depending on the selected curve type (short-term, batch, weekly archive) more dialogs appear.

Curve visualization
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7.6.2 Open a short-term archive

For a short-term archive no additional selection is necessary. 

7.6.3 Open a batch archive
Via 'Batch selection' the area of the corresponding curve archive is selected by the selection 
of year, job number and batch number. 

Batch archives provide the following possibilities: 

Curve visualization
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● Standard view
The measured values of the selected image are related to one batch, the user has to select 
the batch ID in the second step. 

● Free selection
In this way it is possible to take the measured values of the selected image from different 
batches. In a second step up to 8 batches are selected for the curves. The selection is 
measured value-specific. This selection is used as a reference for the selection 'compare 
curves'. 

● Compare curves
With this option the image curves of a freely selectable batch can be set in relation to an 
already selected reference arrangement. Here it is also necessary to select a batch (ID) in 
a second step.

7.6.4 Selecting batches
This dialog is used for the “normal view” and the option “reference curve”. 

● Only those batches can be selected where data has been recorded for at least one 
measured value. 

● A batch is selected by choosing the year/recipe category/order number/batch number

Curve visualization
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7.6.5 Batches “Free selection”

In this dialog the user can select graphs of different batches, 

which are used later as a reference for the option “reference curves”. 

Step 1: Curve
This list contains the configured curves of the earlier selected picture. Adding or removing 
takes effect on the selected measured value.

Step 2: Year/Recipe category/Job number/Batch number
Use these fields to select a batch for a curve.

Step 3: Button '>>'
Add batch to the selected curve.

Step 3: Button '<<'
Remove batch from selected curve.

Selected batches
This list shows the selected batch or batches of the selected curve.

Curve visualization
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7.6.6 Open weekly archive

For weekly archives, the user can select between:
● Normal view

● Free selection

● Compare curves

Please refer to “batch archives” for function description and selection sequence. Weeks are 
compared instead of batches here. After selecting an image for weekly archives (*.ltw), the 
week has to be selected in the next dialog.

7.6.7 Selecting the week

Curve visualization
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The dialog is used for the 'normal view' as well as for the option “reference curve”.

Week/Year
Only those weeks are displayed for which data has been recorded for at least 1 measured 
value.

7.6.8 'Week' selection for ‘Free selection’
After selecting the picture, the following dialog appears and the user can choose the week 
archives for the curves

Step 1: Selecting the curve
This list contains the measured values that have been configured for the picture. The buttons 
'<<‘ and '>>‘ and the 'Selected weeks‘ list are related to the selected curve.

Step 2: Selecting the week/year
Select the week and a year. Only those weeks are shown for which data has been recorded 
for at least one measured value.

Step 3: Button '>>'
This button adds a selected archive (list 'year' and 'week') to a list of weeks of a selected 
measured value.

Step 3: Button '<<'
This button removes a selected week from a list of weeks of a selected measured value.
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Selected weeks
This list shows only those weeks related to the value, selected in the list “curve”.

7.7 Printing pictures
An existing picture can be printed out by selecting "Print" from the “File” menu or pressing the 
button "Print" on the button bar.

The following dialog appears:

Selection
● All

prints all digital and analog curves of a picture

● Analog curves
prints all analog curves of a picture

● Digital curves
prints all digital curves of a picture
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Background
● White

The background color of the picture is white

● Normal
The background color of the picture corresponds to the color of the screen (Windows 
settings)

Part of the picture
● Current sub picture

prints the actual selected part of a picture

● All
prints all curves that are displayed on the screen (full time axis and y-axis).

Button "configuration" 
Opens the standard printing dialog, 

the user can select a printer and can modify options.
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7.8 Hide/Unhide trend curves 

7.8.1 Hide curves
Curves shown in a picture can be hidden or shown by pressing the button with name of the 
measured value.

The scale is being hidden according to its curve.

7.8.2 Unhide curves
Pressing the button again shows the curve. By pressing the 'Show all analog curves' button 

 or by selecting 'Functions → All curves’ in the menu, all hidden curves are visible again.

7.8.3 Unhide only one curve
By clicking on a single curve within the picture (left mouse button), all other graphs are hidden 
and only the selected curve will be displayed.

7.8.4 Hide/Unhide scaling
The scaling can be unhidden and hidden by pressing the button that is labeled with the 
dimension.

7.9 Ruler

7.9.1 Ruler

Button of the toolbar

Select ‘Functions/marker’ or press the F3 function key or click on button “marker” on the symbol bar,  the picture shows a 
white vertical line, called "marker line".
 Showing the values
In the upper part of the picture the absolute values of the graphs (crossing point with the marker line) together with its time 
base are shown.
For digital values the state value (0 or 1) is given on the right side of the digital bar.
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 Move marker line
The marker can be moved horizontally over all graphs with the cursor while pressing the left mouse or trackball button. The 
time and y-axis value are updated automatically. By pressing F3 again or clicking the button “marker line” of the button bar 
the application switches back to the normal mode.

7.9.2 Difference between two marker lines
Select "difference marker lines" from the menu “Functions” or via Shift + F3, provided the 
function "marker line" has been activated. 

The picture shows a second vertical, white marker line, called "difference marker line". Within 
the upper part of the picture the difference between the curves (cross point of marker lines 
with a curve) between marker line 1 and 2 is shown. The marker can be moved horizontally 
over all graphs with the cursor while pressing the left mouse or trackball button. The difference 
and time values are updated automatically. Pressing Shift+F3 again resets the application to 
normal mode.

7.9.3 Zooming
Zooming into parts of a picture can be performed by pressing the left mouse button and drawing 
a rectangle within the picture (upper left to lower right corner). A white outlined rectangle marks 
the selected area, and after releasing the left mouse button, the new zoomed in part will be 
displayed.
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7.9.4 Rezoom

Button of the toolbar

Select "Rezoom" from the menu “Functions” or press Shift + F5 or click the button "Rezoom" on the button bar. The scales 
are reset to their original values (full scale) and revert to normal format.

7.9.5 Redraw curves
Selecting "Functions/Redraw" redraws all curves of a picture,  often used for reference curves. 
Moving graphs sometimes causes parts of curves to be invisible.

7.9.6 Select new week or batch
Selecting "functions/new" or pressing F2 depending on the last opened archive type opens 
the dialog batch archive or weekly archive. 

7.9.7 Display range
By selecting "functions/range", the user can select a range of time.

7.9.8 Standard functions

● Button bar  
Selecting "options/button bar" unhides and hides the button bar.
● Status bar  
Selecting "options/status line" unhides or hides the status bar.
● Function keys  
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Selecting "options/function keys" unhides or hides the meaning of the functions keys.
● Standard size  
Selecting "options/standard size" unhides the whole picture on the screen.
● Quit ICM

Selecting "quit/ICM error" or pressing the button "quit all ICM errors" on the button bar or pressing F11 
quits all ICM errors.
● Quitting horn

By selecting the function "Acknowledge horn" or by clicking the icon "Acknowledge the signal horn" in 
the button bar or by activating the function key F11 the signal horn can be acknowledged.
● Resetting 

password
By selecting the function "Reset password" or by clicking the icon "Reset validity of the password" in 
the button bar the validity of the password is reset.

7.9.9 Changing the display mode
Selecting "options/viewing mode" opens a dialog update view with the following options:

● Don’t update
The shown graphs are not updated.

● Scroll
The shown graphs are updated, whereby only a part of the time scale (and the curve) is 
visible.

● Trace
The shown graphs are updated, whereby the whole time scale (and the curve) is visible.
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7.9.10 Compare curves
The following dialog is called via menu ‘Options → Compare curves’

This window can be opened as an additional (modeless) dialog on top of the curve window 
and is used to select certain curves, whereby the selected curve is shown in black color. 

A selected curve can
● be moved (time) left by pressing '<‘ and '<<‘.

● be moved (time) right by pressing '>‘ and '>>‘.

● be left in its current position by ‘take over’ and affects only the view not the archive file.

● be switched on (visible) or off (hidden).

7.9.11 Help
Menu input “Help” offers assistance for:

● System ALT+F1
● System index  
● Curves F1
● Curves index  
● Information about the application (version).  
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7.10 Command line arguments

The application can be started with the following command line arguments:

Case 1: trends.exe <p1> <p2> <p3> ... <p12>
● <p1>: Display type

c: application is started 'normally' with menu
p: application is started without a menu.

● <p2>: Image name
Name of the trend image without path but with file extension (Weeks -> *.ltw, Batches -> 
*.ltb or Short-term picture -> *.st)

● <p3>: Year
Specification of the year for batches or weekly archive. The value is not relevant for short-
term archives. If '-', the current year is substituted

● <p4>: Week
Only relevant for weekly archives. For other archive types, '0' is used. If '-', the current 
calendar week is substituted

● <p5>: Order number
Only relevant for batch archives. For other archive types, '0' is used. Substitution with 
$Variable name for current order number is possible.

● <p6>: Batch number
Only relevant for batch archives. For other archive types, '0' is used. Substitution with 
$Variable name for current batch number is possible.

● <P7>: Recipe category
Only relevant for batch archives. For other archive types, '0' is used. Substitution with 
$Variable name for current recipe category is possible.

Example: trends.exe p T_PCU1LZ.ltw 7 7 (only 4 parameters since this is a weekly archive)

Case 2: Substitution with '$Variable name':
● A variable is defined in the process picture which contains the value for the substitution and 

a name is configured for this variable.

● The variable name is given for the parameter as $Variable name. The parameter is then 
supplied with the current variable value by the runtime system.

Example: Trends.exe p Test.ltb - 0 $Order $Batch $Rcat

● An integer variable is created for the current batch number in the process picture which 
shows the batch number from the unit data set. This variable is called "Batch".

● In the same way, a variable named "Order" is created for the order number

More optional parameters for mode “application without menu”.
● <p8>: title (maximum length 28 characters)

● <p9>: horizontal (x) position of the upper left corner of the app window

● <p10>: vertical (y) position of the upper left corner of the app window
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● <p11>: window width

● <p12>: window height

7.11 Examples of comparison curves
 

Braumat provides the option of comparing the saved curves of a curve display. 

For weekly curves, the curves of different calendar weeks can be compared with one another; 
for batch curves, the curves of different batches can be compared with one another.

Below is an example showing the selection of comparison batch curves. Weekly curves are 
selected in the same way, except that the selection is made via "Year/Calendar week" instead 
of "Year/Order number/Batch number".

BRAUMAT differentiates between the "Free selection" and "Compare curves" options for 
selection of comparison curves.

Use the "Free selection" option to display and compare individual curve shapes (of an individual 
measured value) with recorded curve shapes of the same measured value for different batches 
or weeks in one curve display. It is possible to compare up to 8 measured values of different 
batches simultaneously.

Use the "Compare curves" option to compare defined reference curves with all curves of a 
curve display of a different batch (or calendar week in the case of weekly curves) using the 
"Free selection" option. An example is shown below.

7.11.1 Curve comparison with the "Free selection" option
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Select "batch curves" and "image name" (here LT.ltb) and the "Free selection" option to open 
the "Batch selection" window, which enables the normal selection of "Year/Order number/
Batch number" on the left, the selection of the curves of this curve image at the bottom right, 
and the selection of "Selected batches" at the top right. In the following, no batches have been 
selected yet for the "GI129" measurement.

Batches are selected separately for each curve (measured value in lower right field). In the 
example, the measured value GI129 is selected here, along with the Year 2006, Order number 
104, and Batch number 104 on the left. Clicking the ">>" button causes the selection to be 
displayed in the top right field (the selection also works by double-clicking on year, order 
number, or batch number in the left selection area). 

As shown in the figure, the measured value GI129 of the server IOS102 is selected from the 
year 2006, order 104, and batch 104.

Curve visualization
7.11 Examples of comparison curves

Batch trending
64 Function Manual, 11/2012, A5E00239387-09



By selecting multiple batches on the left, it is possible to select up to 8 candidates for a 
measured value, which are then displayed together in a curve window.

Select additional curves (measured values) in the same way if you want to display a common 
representation of various measured values in one curve window later. The selection of the 
selected batches of other curves will be retained.
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Press OK to open the following curve display:
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When comparison curves are open, you access the operating window for the comparison 
curves with "Options - Compare curves".

In the Compare curves selection window, the following is possible: 1) after selecting the "Curve" 
via the drop-down menu at the very bottom, individual curves can be selected in the list field 
(the blue bar shows the selected batch), which then turn black; 2) curves can be displayed 
and hidden ("ON/OFF" button), which is indicated with an X in the "Visible" column; 3) curves 
can be shifted over the time axis using the arrow or double-arrow buttons (small or large 
increments, respectively, to left or right).
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7.11.2 Curve comparison with the "Compare curves" option
To use the "Compare curves" option, the reference curves must first be defined for the 
comparison using the "Free selection" option. This takes place as described above, with curve 
image "MTK1" in this case.

The "TI102" and "LI102" curves of year 2006 with order/batch number 10 are defined as 
references.
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After confirmation with "OK", these two curve shapes will be displayed.

Curve visualization
7.11 Examples of comparison curves

Batch trending
70 Function Manual, 11/2012, A5E00239387-09



The comparison curve is selected using the "File->Open->Batch archives" function:

The "Compare curves" option is used to open the selection window for the batches:

Here you select the comparison batch. You do not define the curve(s) themselves here, 
because all curves of the respective curve image of this batch will be displayed. It is therefore 
important to define a meaningful grouping of curves with this option (less is more).

After confirmation with "OK", the curve display will now appear as follows:
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Use "Options - Compare curves" to display a window in which you select both the curve itself 
(drop-down menu at the bottom) as well as the reference and/or comparison curve. The 
selected curve of the batch - here batch number 100 – that is highlighted with a blue bar, is 
represented in the curve display in black. It can be displayed and hidden ("ON/OFF" key) and 
shifted with respect to time using the arrow keys, in order to achieve overlap with the reference 
curve.
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If the curves of another batch are to be compared, this batch is selected with the "Compare 
curves" option as described above. The reference curves remain the same as before. Thus, 
it is possible to successively compare multiple batches with references.
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Archive editor 8
8.1 Overview

The archive editor is a client application, used primarily for editing manual values. The view 
shows a table with a time scale value and the measure value as columns. Several graphs can 
be edited in the same row (same time column).

The program cannot be started by means of the SISTAR menu, but must be opened directly 
in Windows:

● In the Explorer, select the "windcs\sys" folder.

● Double-click 'archedit.exe' to start the program.

● You can also create a shortcut to 'Archedit.exe' on your desktop.

8.2 Configuration
Similarly to the visualization of curves, the archive editor also uses views, but they have to be 
manually configured with an ASCII editor.

Folder and file name syntax for archive views:

Path: '\windcs\Trend\picture'
File extension: '*.man'

Structure of a view:
The number of shown measured values must be configured according the following rules, at 
most 16 values can be displayed.

[ArchiveSet]
Values=6

The next section is 'values‘ with a key per measure value.

[Values]
; the list of measured values is specified with this key
;<Ios-number>,<number of measured value>
Value1=2,1
Value2=2,2
Value3=2,3
Value4=2,4
Value5=2,5
Value6=2,6
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Configuration of file 'rendman.ini‘
Using manual inputs, configure key StartMark like this (file 'trendman.ini'):

[App]

StartMark=1

Access rights
For saving manual inputs, the user right 'TRENDMAN‘ must be configured. 

8.3 Printing
The measured values can be printed as a table, the margins can be configured in file 
‘arch_frm.txt’

located in the global text folder '..\texte.x\arch_frm.txt'.

Structure:

line default value position
1 Date: Upper right corner; current date will be appended
2 Documentation curve 

archive
Top centered

3 Customer: 
sample_customer

Lower left corner

4 Plant: sample_plant Lower left corner
5 Page: Lower right corner; current page number will be appended

8.4 Command line arguments
The application can be started with the following command line arguments: 

archedit <p1> <p2> 

<p1> What to do with the last value ?
The following values are possible:

● /p: last value will be sent to the SIMATIC.
● /pe: last value, time, order and batch number are sent to the SIMATIC.
● /n: nothing will be sent.
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<p2> type of archive
Possible values:

● w weekly archive

● b batch archive

● h manual archive

8.5 Configurations of "archedit.ini“

Section [archive]

Autostart
1: Display last selection again
0: Work with the 'open' dialog after start
JumpToEnd
1: jump to the last value after selection
0: jump to the first value after selection
AskBeforePcuSend
1: Query, before value goes to SIMATIC
0: Send value to the SIMATIC without query
MenuAppl
bed: The user applications are displayed in the program menu
sys: The system applications are displayed in the program menu
PcuFunction
1: Display menu items 'Send value to a PCU'
0: Don’t show menu items for 'Send value to a PCU'
ValWidth
Width of columns for the value
MaxEditDS
Number of maximum displayed curve points.

8.6 Special functions to archive editor

Last change to PLC
With this function the last value is always sent to PLC. The address is in the measured value 
description list. The most recently modified value is shown in the first column of the table (*). 
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Last change and additional data to PLC
In addition to the value, the date, the time, the order and batch number are also sent to the 
PLC.

Addressing
Data is filed at the address given in the measured value description list.

If the application has been started with option ‘/pe’, additional data is also stored next to the 
given address in the measured value description list.

Adr (=MWL): changed value
Adr + 2 Bytes: second
Adr + 3 Bytes: value 1 = value has been written  

and must be reset by the user program.
Adr + 4 Bytes: hour
Adr + 5 Bytes: minute
Adr + 6 Bytes: day
Adr + 7 Bytes: day of the week
Adr + 8 Bytes: year
Adr + 9 Bytes: month
Adr + 10 Bytes: Job number
Adr + 12 Bytes: Batch number

The user program should reserve those addresses beyond the value. This function can only 
be used by user programs. 
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8.7 Working with the application

Open
Open a picture by

● Selecting the file "Open" in the menu 'file'.

● Clicking on the icon  in the button bar.

● By activating the function key F2.

A dialog appears, please select a batch

Example of a called file:
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Save
Press this button on the button bar or select "file/save" to save the file on the disk.

 

 Note

The save function is possible only for so-called ‘manual archives’. These may contain type 
4 measured values (=manual type) exclusively. The determination of the measured value 
type occurs with the application ‘Measured value description list’ (see chapter Measured 
value description list (Page 35)). For this purpose it is recommended to define a dedicated 
view description, which contains only measured values of type 4. When opening such a 
manual archive view, the batch selection dialog appears too. The selected batch is used, 
however, only for definition of file location of the manual archive in the corresponding list here. 
The manually entered values are put aside to the existing measured values.

 

 

Print file
An existing picture can be printed out by selecting "Print" from the “File” menu or pressing 

the button "Print" on the button bar.

Select "file/print" or click button "print" on the button bar to print a picture, a dialog appears 
asking for options: 

‘All data records’ prints all data sets

'Selection' prints only a range of data sets
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Selecting ‘printer’ opens the standard printer dialog.

Add value
Select "file/add value" to add more values.

Delete value
Select "file/delete value" to delete values from the list.

Append value
Select "file/append value" to add more values to the list.

Options
● Button bar

● Status bar

● Function keys

Acknowledgement
● Status bar 'Quit ICM errors‘

● Quitting horn

● Resetting password

Help
● System ALT+F1

● System index

● Information
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What to do with errors? 9
9.1 Problem

No Error description Todo
1 Visualization does not signal a connection to 

the trendmanager (server)
Check server entries in file 'trendman.ini'

2 Problems printing on a 
printer of type HP 550 C

Check configuration in file kurven.ini
[Select]
BitsPixel=0
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